A Tutorial Introduction to Carpet

by Kevin Whitley

When vyou first start Carpet you are presented with a bewildering set of buttons, squares and
menu options, all of which do something. This document will introduce you to the tools a few
at a time, allowing you to make ever more complex designs.

This document will be much more useful if you are actually running the Carpet program while
reading. So, print this out, start up the program and we'll begin.

Getting Started
The first items we will consider are all on the screen. They are:

Pattern - the large black square. This is where your design will take shape.

Generator - this is the grid of squares. When you start Carpet it will have a simple design: a
3x3 in black with the middle square white. (I will refer to this design as the Sierpinski design.)
Just look at the generator now.

Stamp button - this is the most important button on the screen, the fundamental operation of
Carpet. Whenever you press the stamp button the design on the generator will be
transferred, in some fashion, to the pattern.

Restart button - used to reset the pattern back to its original plain black state.

Try This: Click several times on the stamp button and notice what happens. The design in
the generator is stamped on the pattern in decreasing scales. You can keep stamping until
the stamp button is grayed out, in which case your last stamp created patterns at the scale of
1 pixel.

If you press the restart button and then click stamp again, you will get the same pattern. By
the way, this particular pattern is a fractal known as the Sierpinski carpet. Two dimensional
fractals of this general type are known as carpets - hence the program's name.



What is going on here? Let's look in detail at the first two stamps. The first stamp acts like
an overlaying of the generator onto the entire pattern, which looks like one large square.

The first stamp putz a
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The generator consists of nine squares, and now, if we look at the pattern in a smaller scale it
also consists of nine squares, one square corresponding to each square of the generator.
The second stamp then overlays the generator design on each of these smaller squares.

The second stamp piMs ..
a copv of the generator EEE

on each squareof the i W = .
first stamng. [ | [ ] \H..

And rezultz in a pattern that
looks like this:

And so on to smaller and smaller scales. You might notice the vertical bar to the left of the
pattern. This is the scale indicator and will be discussed later, but for now notice that it
shows the size of the square that the generator will stamp onto.



Changing the Generator
While the Sierpinski carpet is interesting, you probably want to do more. Now we will
consider the

Generator - the individual squares of the generator can be toggled with clicks, much like the
"fatbits” mode in MacPaint™.

Try This: Get a fresh pattern by clicking on restart. Now change the design on the generator
by clicking on it's squares. Click the stamp button until it is grayed out. The designs you are

making are carpet fractals.

Designs you can make:

You don't have to keep the generator the same the whole time you are working on a
particular design. You can change the generator at any time.

Try This: Restart. Change the generator design back to the Sierpinski design. Stamp. Now
change the generator design to a little X - all black except for the 4 middle squares on the
sides. Stamp. Alternate the two designs on each stamp.
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Two Easy Buttons
Now we'll quickly consider the effects of the buttons:

Undo - if you make a stamp that you regret, click undo and its effect will be undone.
Undoing again redoes it.

Invert - inverts the entire pattern black to white, white to black.

Try This: Restart. Stamp a few times with some design. Undo. Then undo the undo. Then
undo again. Often the Undo button is a useful way to quickly toggle a stamp on and off again
so you can decide whether you like it or not. Try inverting the pattern, stamp, then invert
again.

Modes

So far, whenever you have stamped, you have taken the design on the generator and put it
onto the pattern by eating away the black, changing black to white. Carpet gives you three
stamping modes:

Black To White - This is what you have been using. It takes black areas of the pattern and
makes them look like the design in the generator, thereby changing black to white. It works
like a logical AND between the pattern and the generator (black being 1, white 0).

White To Black - This will take white areas of the pattern and make portions black. Itis like a
logical OR.

Both - This will take black areas and make them white, white areas and make them black. It
works like a logical NOT XOR.

Confused? The modes are hard to talk about but easy to see.

Try This: Restart. Set the generator back to the Sierpinski design - all black but one white
square in the middle. Set the mode to Black To White. Stamp twice. Notice how the second
stamp didn't disturb the large white square in the middle which was created with the first
stamp. Now restart again.

Try This: Set the mode to Both. Stamp twice. The first stamp worked exactly the same as
when you were in mode Black To White. That's because there was nothing but black in the
pattern. But on the second stamp not only were the black areas eaten away, but some of the
white area was filled. Stamp until the Stamp button is grayed out. The resulting pattern is
like and not like the pattern you get from mode Black To White.



Try This: Now restart again. Set the mode to White To Black. Stamp. Nothing happened!
That's because there is no white to change to black. Click undo to undo that change. Now
invert, to change the pattern from all black to all white. Now when you stamp you get the old
familiar pattern. Stamp again. Do you understand what happened? The large white square
in the middle was stamped with black, leaving a smaller white square. If you stamp until the
stamp button grays out you will have a pattern which is all black except for a single pixel in
the very center.

There are some interesting relationships between a pattern and the related pattern formed by
the inverse generator design, their inverses, and the patterns with these generator designs

using Black To White or White To Black.

Designs you can now make:
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Controlling the Stamp Size
So far each stamp you have made has decreased in size. You actually have control over
what size the stamp will use. New tools are:

Scale indicator - the black line next to the pattern. It indicates the scale that the next stamp
will have.

Size up box - the small box below the Scale indicator. When you click in it, the scale
increases one step.

Size down box - the small box above the Scale indicator. When you click in it, the scale
decreases one step.

Autosize menu options - these control autosizing. When autosizing is on, the scale
decreases by one step after each stamp.

What does "one step” mean? Each stamp operation transfers the design on the generator to
the pattern while stretching the generator so that its vertical size is the same as the scale
indicator. Going down one step means that a portion of the pattern which was considered
one square is now considered to be as many squares as there are on the generator. (You
might look back at the picture illustrating the stamp). Going up one step is the opposite.



Up till now the scale has decreased by one step after each stamp (autosize is on by default).
But now you can use the size boxes to change the scale however you want. This greatly
increases the possible complexity of carpet you can make.

Try this: Restart. Put the Sierpinski design on the generator. Make the mode Black To
White. Stamp to the smallest scale; this gives the Sierpinski carpet. Now click on the size up
box until the scale is back up to the size of the full pattern. Now change the generator to a
little plus sign (make the four corners white, all the rest black). Change the mode to Both.
Now stamp again a few times. Quite different, no?

Try this: Make some favorite carpet pattern. Now click on the size up box until the scale is
equal to the size of the full pattern. Choose the menu option Autosize Off so that you have
complete control over the scale. Put a design in the generator. Make the mode Both. Now
stamp. Notice that the effect was that the areas of the Pattern that correspond to white
squares in the generator are inverted. Notice also that the scale didn't change. Stamp
again. This stamp cancels out the previous one. This was not an undo; it is always the case
that two stamps in mode Both, with the same generator, at the same scale, cancel out. This
is true even if there are intervening stamps.

Try this: Make the Sierpinski carpet. Now we want to put something into that large white
square in the middle - but we don't want to disturb the rest of the carpet. We will use the
reversibility of mode Both. Get the scale equal to the pattern size (largest possible). Put an
interesting design on the generator. Change the mode to Both and turn Autosize on. Click
down to a scale of 1 pixel - the stamp button grays out. The Sierpinski carpet looks like it
has disappeared, but the information is all still there and recoverable. Make the scale largest
again. Change the mode to Black To White. Remembering the design on the Generator (this
is important!) change the generator to the Sierpinski design. Stamp once. Make the scale
larger again, change the mode back to Both and put your design back in the generator. Now
stamp down to a scale of 1 pixel. Notice how the Sierpinski carpet reappears. And now we
have something in the middle.



The last demonstration shows something important: mode Both modifies information but
doesn't destroy it. Modes Black to White and White to Black both destroy information - they
are non-reversible. If you use too much mode Both in your carpet patterns things will tend to
get muddy; everything will run to gray. But too much of the other modes results in a sparse
carpet. Interesting carpets tend to have a mix of modes.

Designs you can now make:

The Pattern Stack
Up to now whenever you wanted to work on a new pattern you had to start from scratch,
using restart to erase your previous work. But you can keep more than one pattern at a time.

New Pattern - a menu item under Options. When you choose it you will start a new pattern,
without deleting the old one.

Pattern Stack selector - the row of boxes underneath the pattern. When you click on a box
you select one of the patterns in the stack.

Edit menu - patterns can be copied and pasted, both within Carpet and to other programs.

Try this: Create some interesting pattern. Now choose New Pattern. Now create another
pattern. Click on the far left box of the pattern stack selector, you will get your earlier pattern.
Notice also that the generator design is where you left it for this pattern, and so is the scale.

Patterns created earlier are to the left in the pattern selector. When you paste something, it
is added after the currently showing pattern. What goes on the Clipboard? A picture which is
readable by most Macintosh applications. That's how the pictures in this document got here.
By the way, you can paste things into Carpet that aren't carpets. They will be placed into the
upper left hand corner of the pattern and clipped.



Undo still means undo the last stamp. This means the last stamp over all patterns in the
stack. If the pattern that was stamped isn't showing when you undo that pattern will be
selected. The edit menu undo is the same as the undo button.

Clear in the Edit menu will delete the current pattern from the stack. It is not undoable.

File operations

Let's say you've created a pattern stack with 10 interesting patterns in it. You can Save your
work. Standard file operations are supported: Save, Save As, New and Open. The pattern
stack will be saved in a Carpet document which is then double-clickable to start Carpet. You
can have more than one Carpet window open at a time. In which case each window
maintains its own undo information - the undo menu refers to the frontmost window.

Printing

A paper copy of an interesting design is a nice thing to have. When you choose the Print
menu item the currently showing pattern in the frontmost window will be printed, centered on
the paper. To get good results on an Imagewriter you should use the Tall Adjusted option so
that the pixels in your design will come out square. When you print with a LaserWriter you
should turn Bit Smoothing off to make the pattern look as much like the design on the screen.
However, you can achieve very interesting effects with Bit Smoothing on - try it.

Changing the Generator size
All of our patterns up till now have used a generator which is 3x3. At the bottom right of the
generator is a small rectangle which is the

Generator sizer - Click and drag on it to change the generator size to anything from 2x2 to
6X6.

You can change the generator size at any time but in general using two generators of
different sizes on the same design will not be interesting (but maybe you'll disagree!). But if
you change the generator size and then immediately choose the New Pattern menu option
you will get a new pattern suited to the new generator size.

Try this: Click and drag the generator sizer so that the generator has the size 2x2. Make
one of the squares white. Now stamp until the stamp button grays out. Triangles!



You may have noticed that the pattern started out at a different size. Why is this? (If you
don't care you can skip over the explanation. Just go to Combinations.) Because the
generator is 2x2 each downward step in scale reduces the stamp size by a factor of 2. So,
for the generator to stamp the pattern without coming out short at an edge, the size of the
pattern must be a power of 2: in this case 256. Similarly when the generator is 3x3 the size
is a power of 3: in this case 243, which is slightly smaller.

Try this: Change the generator size so that it is 6 pixels horizontally and 2 vertically. It
becomes very small.

Another way to look at the initial pattern size is to start at the smallest scale and work up.
The smallest squares are 1 pixel, the next biggest are larger by the size of the generator. In
our example that would be 6x2. The next bigger scale is 36x4 pixels then 216x8 pixels. The
pattern can't get any bigger because there isn't room on the screen for the next bigger scale
of the generator with a size of 6.

Designs you can make now:
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Combinations

Now you have a stack with a couple of patterns on it. You can look at and modify them one
at a time by selecting them using the pattern selector. You can also combine the patterns,
adding design to design. You need

In Combination - a Pattern menu item. Selecting it changes whether the pattern is in the
combination. The item is checked if the pattern is in.

Combination - a check box. When checked the current pattern is not shown, (though it is
still acted upon as if it were showing). Instead the combined pattern shows. If you have a
large screen Mac (say a Mac Il) this item will not exist. You'll always see both the current
pattern and the combination.

Copy Combination - an Edit menu item. Use this to copy the combination, rather than the
current pattern, onto the clipboard.

Print Combination - a File menu item. Use this to print the combination, rather than the
current pattern.

Try this: Choose New from the File menu. This will give you a brand new window with a new
stack in it to work with. Click stamp till it grays out, getting the Sierpinski carpet. Choose
New Pattern (getting a new 3x3 pattern). Now put a plus sign design on the Generator -
make the four corners white, all the rest black. Stamp the new pattern until the stamp button
grays out. Now go to the Pattern menu and choose In Combination. Go back to the
Sierpinski carpet (click the leftmost box of the pattern selector). Choose In Combination
again. Now Click on the Combination check box. The combination pattern will appear: the
overlay of the two patterns we said were in the combination. Now, if you had a large screen
Mac, like a Mac I, there is always an area, the same size as the pattern, set aside for the
combination. As soon as you set a pattern to be in the combination the combination will
appear. You will always be able to see both the pattern and the combination simultaneously.

There are a couple of points worth noting. Not all the patterns in the stack have to be in the
combination - just the ones you want. If you perform an operation while the combination is
showing, it will act on the current pattern, not the combination. This is so that you can
manipulate a pattern and see what effect that has on the combination. If you show the
combination when there are no patterns in the combination, you will see nothing. And if you
Copy combination and then paste it you will then have a pattern which looks like the
combination but can be manipulated as a pattern.



A powerful trick: You may have some pattern in mind that you want to make and put in the
current stack but you realize that you need to use combination to make it. Rather than going
through the current stack and taking things out of the combination, start a new stack in a new
window (using New from the File menu). Build the pattern there and then copy your final
result over to your main stack.

Designs you can make now:

Color

In the Pattern menu are menu options for colors. Use them to select the color of the current
pattern. What good is this on a Black and White screen? Well, you could save the stack and
display it on a color Mac. Or, if you print on an ImageWriter Il with a color ribbon you will get
colors. Also, the color white works even on a Black and White Mac. Try it and see what
happens.

When all the patterns in your stack are not black it is important to understand that when you
display the combination the earlier patterns (which are to the left on the pattern selector) are
underneath the later patterns. The order of the patterns is important. It is easy to rearrange
the order by using cut and paste.

What new designs can you make now? | can't show you in this document. But try Carpet on
a color Mac, the results are spectacular.



